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UNIT -1 

BASIC COMPUTER OPERATION 
 

Different Components of a Computer: 
 
Below diagram shows the different components of a Computer System – 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Switch on, Shut down and Restart Process: 

 

 When we want to switch on a PC, we have to first check the power supply is on, then press the 
power button on the CPU. It will start the Computer. 

 When we want to shut down the PC, first we have to click on the start button on the task bar, click on 
Power and select Shut Down, It'll shut down the Computer. 

 Similarly, when we want to restart the PC, we click on start button, select Power and select restart, 
it'll restart the Computer. 

 

Booting Process 

 
Booting is a  startup sequence  that start    the operating   system  of a computer   when  it is turned on. A 
boot 
sequence is  the initial set of operation    that the computer  performs  when it is   switched  on. Every 
computer   has a boot sequence. Booting can  be of two  types: 
 

Cold Boot 

 
When you turn the computer   off and back on, you're performing what's called a cold boot .During a cold 
boot, the computer runs self test  on  its hardware  and loads  its operating  system  before  it's ready for you 
to use. 
 
Warm Boot 

 
When you  restart  the    system  without  interrupting  power,  It's a warm boot. A warm boot is   usually  
done from the operating  system and doesn't initiate the computer's   self test routine.  To perform  a warm 
boot click the power icon on the start screen, If  shown,  and then click "Restart." 
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UNIT – 2 
PERSONAL COMPUTER SYSTEM 

 
 

Power supply form factor- 

 
Form factor for computers refers to the size, shape, and physical specifications of hardware or hardware 
components. Computer form factor is used to describe any physical aspect of a computer system. Form 
factor is very important for connection compatibility. 
 
Importance of form factors  

 

 The most obvious example of a computer form factor is the difference between a desktop and a 
laptop computer. Although the same parts are present in each, they are shaped and attached 
differently. For example, the keyboard from a desktop computer cannot fit into the keyboard space of 
a laptop computer. 

 

 The form factor design of hardware is dependent on, and influenced by, the form factor design of the 
components that go into the larger hardware unit. The size and the shape of the component are 
affected as are the connections and power specifications. Most component manufacturers have 
standardization rules so that components work together electrically and electronically and that they 
physically fit into the available space. 

Inside view of a CPU -  

The following are the different major components that are present inside a CPU case - 

Motherboard 
 
The motherboard is the computer's main circuit board. It's a thin 
plate that holds the CPU, memory, connectors for the hard drive 
and optical drives, expansion cards to control the video and 
audio, and connections to your computer's ports (such as USB 
ports). The motherboard connects directly or indirectly to every 
part of the computer. 
 
 
 
 
Processor 
 

The central processing unit (CPU), also called a processor, is located 
inside the computer case on the motherboard. It is sometimes called the 
brain of the computer, and its job is to carry out commands. Whenever 
you press a key, click the mouse, or start an application, you're sending 
instructions to the CPU. 
 
The CPU is usually a two-inch ceramic square with a silicon chip located 
inside. The chip is usually about the size of a thumbnail. The CPU fits into 
the motherboard's CPU socket, which is covered by the heat sink, an 
object that absorbs heat from the CPU. 
 
A processor's speed is measured in megahertz (MHz), or millions of instructions per second; and gigahertz 
(GHz), or billions of instructions per second. A faster processor can execute instructions more quickly. 
However, the actual speed of the computer depends on the speed of many different components—not just 
the processor. 
 
 



3 
 

 
 
RAM (random access memory) 
 

RAM is your system's short-term memory. Whenever your 
computer performs calculations, it temporarily stores the data 
in the RAM until it is needed. 
 
This short-term memory disappears when the computer is 
turned off. If you're working on a document, spreadsheet, or 
other type of file, you'll need to save it to avoid losing it. 
When you save a file, the data is written to the hard drive, 
which acts as long-term storage. 
RAM is measured in megabytes (MB) or gigabytes (GB). The 
more RAM you have, the more things your computer can do at the same time. If you don't have enough 
RAM, you may notice that your computer is sluggish when you have several programs open. Because of 
this, many people add extra RAM to their computers to improve performance. 
 
Hard drive 
 
The hard drive is where your software, documents, and other 
files are stored. The hard drive is long-term storage, which 
means the data is still saved even if you turn the computer 
off or unplug it. 
 
When you run a program or open a file, the computer copies 
some of the data from the hard drive onto the RAM. When 
you save a file, the data is copied back to the hard drive. The 
faster the hard drive, the faster your computer can start up 
and load programs. 
 
Power supply unit 
 
The power supply unit in a computer converts the power from the 
wall outlet to the type of power needed by the computer. It sends 
power through cables to the motherboard and other components. 
If you decide to open the computer case and take a look, make 
sure to unplug the computer first. Before touching the inside of the 
computer, you should touch a grounded metal object—or a metal 
part of the computer casing—to discharge any static buildup. Static 
electricity can be transmitted through the computer circuits, which 
can seriously damage your machine. 
 
Expansion cards 

Most computers have expansion slots on the motherboard that allow you to add various types of expansion 
cards. These are sometimes called PCI (peripheral component interconnect) cards. You may never need to 
add any PCI cards because most motherboards have built-in video, sound, network, and other capabilities. 
 
Video card 
 
The video card is responsible for what you see on the 
monitor. Most computers have a GPU (graphics processing 
unit) built into the motherboard instead of having a separate 
video card. If you like playing graphics-intensive games, you 
can add a faster video card to one of the expansion slots to 
get better performance. 
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Sound card 

The sound card—also called an audio card—is responsible for what you hear in the speakers or 
headphones. Most motherboards have integrated sound, but you can upgrade to a dedicated sound card for 
higher-quality sound. 
 
Network card 
 

The network card allows your computer to 
communicate over a network and access the 
Internet. It can either connect with an Ethernet cable 
or through a wireless connection (often called Wi-Fi). 
Many motherboards have built-in network 
connections, and a network card can also be added 
to an expansion slot. 
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UNIT – 3 

COMPUTER LAB SAFETY AND STUDY OF LAB TOOLS 
 

Safe Lab Procedures 
 
Safety guidelines help protect individuals from accidents and injury. They also help to protect equipment 
from damage. Some of these guidelines are designed to protect the environment from contamination 
caused by improperly discarded materials. 
 
General Safety  

 
Safe working conditions help prevent injury to people and damage to computer equipment. A safe 
workspace is clean, organized, and properly lighted. Everyone must understand and follow safety 
procedures. 
Follow the basic safety guidelines to prevent cuts, burns, electrical shock, and damage to eyesight. As a 
best practice, make sure that a fire extinguisher and first-aid kit are available in case of fire or injury. Poorly 
placed or unsecured cables can cause tripping hazards in a network installation. Cables should be installed 
in conduit or cable trays to prevent hazards. 
 
This is a partial list of basic safety precautions to use when working on a computer: 
 

 Remove your watch and jewelry and secure loose clothing. 
 Turn off the power and unplug equipment before performing service. 
 Cover sharp edges inside the computer case with tape. 
 Never open a power supply or a CRT monitor. 
 Do not touch areas in printers that are hot or that use high voltage. 
 Know where the fire extinguisher is located and how to use it. 
 Keep food and drinks out of your workspace. 
 Keep your workspace clean and free of clutter. 
 Bend your knees when lifting heavy objects to avoid injuring your back. 

 
Electrical Safety  
 
Follow electrical safety guidelines to prevent electrical fires, injuries, and fatalities in the home and the 
workplace. Power supplies and CRT monitors contain high voltage. 
 
CAUTION 
Do not wear the antistatic wrist strap when repairing power supplies or CRT monitors. Only experienced 
technicians should attempt to repair power supplies and CRT monitors. 
 
Some printer parts become hot during use, and other parts might contain high voltage. Check the printer 
manual for the location of high-voltage components. Some components retain a high voltage even after the 
printer is turned off. Make sure that the printer has had time to cool before making the repair. 
Electrical devices have certain power requirements. For example, AC adapters are manufactured for 
specific laptops. Exchanging power cords with a different type of laptop or device may cause damage to 
both the AC adapter and the laptop. 
 
Fire Safety  

 
Follow fire safety guidelines to protect lives, structures, and equipment. To avoid an electrical shock and to 
prevent damage to the computer, turn off and unplug the computer before beginning a repair. 
 
Fire can spread rapidly and be very costly. Proper use of a fire extinguisher can prevent a small fire from 
getting out of control. When working with computer components, be aware of the possibility of an accidental 
fire and know how to react. Be alert for odors emitting from computers and electronic devices. When 
electronic components overheat or short out, they emit a burning odor. 
  
If there is a fire, follow these safety procedures: 
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 Never fight a fire that is out of control or not contained. 
 Always have a planned fire escape route before beginning any work. 
 Get out of the building quickly. 
 Contact emergency services for help. 
 Locate and read the instructions on the fire extinguishers in your workplace before you have to use 

them. 
 
Be familiar with the types of fire extinguishers used in your country or region. Each type of fire extinguisher 
has specific chemicals to fight different types of fires: 
 

 Paper, wood, plastics, cardboard 
 Gasoline, kerosene, organic solvents 
 Electrical equipment 
 Combustible metals 

 
It is important to know how to use a fire extinguisher. Use the memory aid P-A-S-S to remember the basic 
rules of fire extinguisher operation: 
 

 P: Pull the pin. 
 A: Aim at the base of the fire, not at the flames. 
 S: Squeeze the lever. 
 S: Sweep the nozzle from side to side. 

 
Analysis of Different Power Fluctuation Types: 
 
Voltage is the force that moves electrons through a circuit. The movement of electrons is called current. 
Computer circuits need voltage and current to operate electronic components. When the voltage in a 
computer is not accurate or steady, computer components might not operate correctly. Unsteady voltages 
are called power fluctuations. 
The following types of AC power fluctuations can cause data loss or hardware failure: 
 

 Blackout: Complete loss of AC power. A blown fuse, damaged transformer, or downed power line 
can cause a blackout. 

 Brownout: Reduced voltage level of AC power that lasts for a period of time. Brownouts occur when 

the power line voltage drops below 80 percent of the normal voltage level. Overloading electrical 
circuits can cause a brownout. 

 Noise: Interference from generators and lightning. Noise results in poor quality power, which can 

cause errors in a computer system. 
 Spike: Sudden increase in voltage that lasts for a short period and exceeds 100 percent of the 

normal voltage on a line. Spikes can be caused by lightning strikes, but can also occur when the 
electrical system comes back on after a blackout. 

 Power surge: Dramatic increase in voltage above the normal flow of electrical current. A power 
surge lasts for a few nanoseconds, or one-billionth of a second. 

 
Power Protection Devices – 
 
To help shield against power fluctuation problems, use power protection devices to protect the data and 

computer equipment: 
 

 Surge suppressor: Helps protect against damage from surges and spikes. A surge suppressor 

diverts extra electrical voltage that is on the line to the ground. 
 

 Uninterruptible power supply (UPS): Helps protect against potential electrical power problems by 
supplying a consistent level of electrical power to a computer or other device. The battery is 
constantly recharging while the UPS is in use. The UPS provides a consistent quality of power when 
brownouts and blackouts occur. Many UPS devices can communicate directly with the computer 
operating system. This communication allows the UPS to safely shut down the computer and save 
data prior to the UPS losing all electrical power. 
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 Standby power supply (SPS): Helps protect against potential electrical power problems by 
providing a backup battery to supply power when the incoming voltage drops below the normal level. 
The battery is on standby during normal operation. When the voltage decreases, the battery 
provides DC power to a power inverter, which converts it to AC power for the computer. This device 
is not as reliable as a UPS because of the time it takes to switch over to the battery. If the switching 
device fails, the battery cannot supply power to the computer. 

 
Procedures for Proper Disposal/Recycling of Hazardous Computer Components: 
 

The proper disposal or recycling of hazardous computer components is a global issue. Make sure to follow 
regulations that govern how to dispose of specific items. Organizations that violate these regulations can be 
fined or face expensive legal battles. 
 
Batteries 
Batteries often contain rare earth metals that can be harmful to the environment. Batteries from portable 
computer systems can contain lead, cadmium, lithium, alkaline manganese, and mercury. These metals do 
not decay and remain in the environment for many years. Mercury is commonly used in the manufacturing 
of batteries and is extremely toxic and harmful to humans. 
 
Recycling batteries should be a standard practice for a technician. All batteries, including lithium-ion, nickel-
cadmium, nickel-metal hydride, and lead-acid, are subject to disposal procedures that comply with local 
environmental regulations. 
 
Monitors 

Monitors contain glass, metal, plastics, lead, barium, and rare earth metals. According to the U.S. 
Environmental Protection Agency (EPA), monitors can contain approximately 4 pounds (1.8 kg) of lead. 
Monitors must be disposed of in compliance with environmental regulations. 
 
Handle CRT monitors with care. Extremely high voltage can be stored in CRT monitors, even after being 
disconnected from a power source. 
 
Toner Kits, Cartridges, and Developers 

Used printer toner kits and printer cartridges must be disposed of properly or recycled. Some toner cartridge 
suppliers and manufacturers take empty cartridges for refilling. Some companies specialize in refilling empty 
cartridges. Kits to refill inkjet printer cartridges are available but are not recommended, because the ink 
might leak into the printer, causing irreparable damage. Using refilled inkjet cartridges might also void the 
inkjet printer warranty. 
 
Chemical Solvents and Aerosol Cans 

Contact the local sanitation company to learn how and where to dispose of the chemicals and solvents used 
to clean computers. Never dump chemicals or solvents down a sink or dispose of them in a drain that 
connects to public sewers. 
 
The cans or bottles that contain solvents and other cleaning supplies must be handled carefully. Make sure 
that they are identified and treated as special hazardous waste. For example, some aerosol cans explode 
when exposed to heat if the contents are not completely used. 
 
Study of General Lab Tools: 
 
For every job there is the right tool. Make sure that you are familiar with the correct use of each tool and that 
the correct tool is used for the current task. Skilled use of tools and software makes the job less difficult and 
ensures that tasks are performed properly and safely. 
 
A toolkit should contain all the tools necessary to complete hardware repairs. As you gain experience, you 
learn which tools to have available for different types of jobs. Hardware tools are grouped into four 
categories: 
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 ESD tools 
 Hand tools 
 Cleaning tools 
 Diagnostic tools 

ESD Tools  

There are two ESD tools: the antistatic wrist strap and the antistatic mat. The antistatic wrist strap protects 
computer equipment when grounded to a computer chassis. The antistatic mat protects computer 
equipment by preventing static electricity from accumulating on the hardware or on the technician. 

 
Hand Tools  
Most tools used in the computer assembly process are small hand tools. They are available individually or 
as part of a computer repair toolkit. Toolkits range widely in size, quality, and price. Some common hand 
tools and their uses are: 
 

 Flat-head screwdriver: Used to tighten or loosen slotted screws. 
 Phillips-head screwdriver: Used to tighten or loosen cross-headed screws. 
 Torx screwdriver: Used to tighten or loosen screws that have a star-like depression on the top, a 

feature that is mainly found on laptops. 
 Hex driver: Used to tighten or loosen nuts in the same way that a screwdriver tightens or loosens 

screws (sometimes called a nut driver). 
 Needle-nose pliers: Used to hold small parts. 
 Wire cutters: Used to strip and cut wires. 
 Tweezers: Used to manipulate small parts. 
 Part retriever: Used to retrieve parts from locations that are too small for your hand to fit. 
 Flashlight: Used to light up areas that you cannot see well. 
 Wire stripper: A wire stripper is used to remove the insulation from wire so that it can be twisted to 

other wires or crimped to connectors to make a cable. 
 Crimper: Used to attach connectors to wires. 
 Punch-down tool: Used to terminate wire into termination blocks. Some cable connectors must be 

connected to cables using a punch down tool. 
 
Cleaning Tools  
 
Having the appropriate cleaning tools is essential when maintaining and repairing computers. Using the 

appropriate cleaning tools helps ensure that computer components are not damaged during cleaning. 
Cleaning tools include the following: 
 

 Soft cloth: Used to clean different computer components without scratching or leaving debris 
 Compressed air: Used to blow away dust and debris from different computer parts without touching 

the components 
 Cable ties: Used to bundle cables neatly inside and outside of a computer 
 Parts organizer: Used to hold screws, jumpers, fasteners, and other small parts and prevents them 

from getting mixed together 
 
Diagnostic Tools  
 
Diagnostic tools are used to test and diagnose equipment. Diagnostic tools include the following: 

 
 

 A digital multimeter, is a device that can take many types of measurements. It 

tests the integrity of circuits and the quality of electricity in computer 
components. A digital multimeter displays the information on an LCD or LED.  

 
 

 A loopback adapter, also called a loopback plug, tests the basic functionality 
of computer ports. The adapter is specific to the port that you want to test. 
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 The toner probe, is a two-part tool. The toner part is connected to a cable at 
one end using specific adapters, such as an RJ-45, coaxial, or metal clips. 
The toner generates a tone that travels the length of the cable. The probe 
part traces the cable. When the probe is in near proximity to the cable to 
which the toner is attached, the tone can be heard through a speaker in the 
probe.  

 
 
 
Although an external hard drive enclosure is not a diagnostic tool, it is often used when diagnosing and 

repairing computers. The customer hard drive is placed into the external enclosure for inspection, diagnosis, 
and repair using a known-working computer. Backups can also be recorded to a drive in an external 
enclosure to prevent data corruption during a computer repair. 
 
Software Tools  
 

Like hardware tools, there are a variety of software tools that can be used to help technicians pinpoint and 
troubleshoot problems. Many of these tools are free and several come with the Windows operating system. 
 
Disk Management Tools  

 
Software tools help diagnose computer and network problems and determine which computer device is not 
functioning correctly. A technician must be able to use a range of software tools to diagnose problems, 
maintain hardware, and protect the data stored on a computer. 
 
You must be able to identify which software to use in different situations. Disk management tools help detect 

and correct disk errors, prepare a disk for data storage, and remove unwanted files. 
 
The following are some disk management tools: 
 

 FDISK: A command-line tool that creates and deletes partitions on a hard drive. The FDISK tool is 

not available in Windows XP, Vista, or 7. It has been replaced with the Disk Management tool. 
 Disk Management Tool: Initializes disks, creates partitions, and formats partitions. 
 Format: Prepares a hard drive to store information. 
 ScanDisk or CHKDSK: Checks the integrity of files and folders on a hard drive by scanning the file 

system. These tools might also check the disk surface for physical errors. 
 Defrag: Optimizes space on a hard drive to allow faster access to programs and data. 
 Disk Cleanup: Clears space on a hard drive by searching for files that can be safely deleted. 
 System File Checker (SFC): A command-line tool that scans the operating system critical files and 

replaces files that are corrupted. 
 
Use the Windows 7 boot disk for troubleshooting and repairing corrupted files. The Windows 7 boot disk 
repairs Windows system files, restores damaged or lost files, and reinstalls the operating system. 
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UNIT -4 

OPERATING SYSTEM 
Basic DOS Commands: 

 

DOS commands are small programs, which are made to perform a particular job. Every DOS command 

performs different task. It is not possible to work on the computer without these commands. There are two types 

of DOS command. 

 

Internal Commands : These commands enter into the computer memory during computer booting. These 

commands are not in the form of any file; so neither they can be viewed nor can be edited or detected. For 

example : MD, CD, TIME, DATE, COPY, COPR CON, TYPE ETC.  

 

External Commands : These commands are stored in the computer list in the form of files. These Commands 

can be viewed, copied, changed or deleted. For example : FORMAT, COPY, PRINT, SYS, EDIT, TREE, SORT, 

PROMPT etc.  

 

Important Internal DOS Commands 

 

MD (Make Directory) : We use this commands to make a new directory or sub directory.  

Syntax : C\:>MD DIRECTORY NAME  

Example : MD STUDENT  

 

CD (Change Directory) : This commands is used to move from one directory to another.  

Syntax : C:\> CD Directory name  

Example : > CD Student  

 

Exit to Directory : 

CD… The command move the subdirectory to parent directory.  

CD\ The command is used to move directly to the root directory.  

 

RD (Remove Directory) : If a Directory which was earlier is ;not required than such directory can be removed by 

using  

Syntax : C:\> RD Directory name  

Example : >RD student  

Note : (a) The directory, which is to be removed, must be empty.  

(b) The directory in which one is working cannot be removed.  

 

TIME - Displays current time and allows it to be changed.  

Syntax: C:\> TIME  

 

DATE - Displays current date and allows it to be changed.  

Syntax: C:\> DATE  

 

CLS - Clears the screen.  

Syntax:  C:\> CLS  

 

DIR - Shows directory information of a diskette: name, size, and the date and time stamp of files.  

Syntax:  C:\>DIR [d:][path] 
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DEL : This command is used to erase the files which are no longer required.  

Syntax : C:\> Del < File name >  

Example : >Del Monu  

 

TYPE : This command is used to view the contents of text file.  

Syntax : C:\> Type <file name>  

   

COPY : This command is used to copy of file from one place to another place. A copy of file is another file with 

the same contents.  

Syntax : C:\>  copy <source> < destination path>  

 

REN : This command is used to rename the file. In REN command two parameters are used. The first is the file 

we want to rename and the second is the new name for the file.  

Syntax : C:\>  Ren <old file name> <New file name> 

 

Basic WINDOWS Operations – 

To use Windows efficiently, you must master a few simple operations, such as pointing and clicking, dragging 
and dropping, and right-clicking. You perform all these operations with your mouse. 

Pointing and Clicking - 

The most common mouse operation is pointing and clicking. Simply move the mouse so that the cursor is 
pointing to the object you want to select, and then click the left mouse button once. Pointing and clicking is an 
effective way to select menu items, directories, and files. 

Double-Clicking - 

If you're using Windows XP's default operating mode, you'll need to double-click an item to activate an 
operation. This involves pointing at something onscreen with the cursor and then clicking the left mouse button 
twice in rapid succession. For example, to open program groups or launch individual programs, simply double-
click a specific icon. 

Right-Clicking - 

When you select an item and then click the right mouse button, you'll often see a pop-up menu. This menu, 
when available, contains commands that directly relate to the selected object. Refer to your individual programs 
to see whether and how they use the right mouse button. 

Dragging and Dropping - 

Dragging is a variation of clicking. To drag an object, point at it with the cursor and then press and hold down 
the left mouse button. Move the mouse without releasing the mouse button, and drag the object to a new 
location. When you're done moving the object, release the mouse button to drop it onto the new location. 

You can use dragging and dropping to move files from one folder to another or to delete files by dragging them 
onto the Recycle Bin icon. 
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Hovering - 

When you position the cursor over an item without clicking your mouse, you're hovering over that item. Many 
operations require you to hover your cursor and then perform some other action. 

Moving and Resizing Windows 

Every software program you launch is displayed in a separate onscreen window. When you open more than 
one program, you get more than one window—and your desktop can quickly get cluttered. 

There are many ways to deal with desktop clutter. One way to do this is to move a window to a new position. 
You do this by positioning your cursor over the window's title bar and then clicking and holding down the left 
button on your mouse. As long as this button is depressed, you can use your mouse to drag the window around 
the screen. When you release the mouse button, the window stays where you put it. 

You also can change the size of most windows. You do this by positioning the cursor over the very edge of the 
window—any edge. If you position the cursor on either side of the window, you can resize the width. If you 
position the cursor on the top or bottom edge, you can resize the height. Finally, if you position the cursor on a 
corner, you can resize the width and height at the same time. 

After the cursor is positioned over the window's edge, press and hold the left mouse button; then drag the 
window border to its new size. Release the mouse button to lock in the newly sized window. 

Maximizing, Minimizing, and Closing Windows 

Another way to manage a window in Windows is to make it display full-screen. You do this by maximizing the 
window. All you have to do is click the Maximize button at the upper-right corner of the window. 

 Use the Maximize, Minimize, and Close buttons to manage your desktop windows. 

If the window is already maximized, the Maximize button changes to a Restore Down button. 
When you click the Restore Down button, the window resumes its previous (pre-maximized) dimensions. 

If you'd rather hide the window so that it doesn't clutter your desktop, click the Minimize button. This shoves the 
window off the desktop, onto the Taskbar. The program in the window is still running, however—it's just not on 
the desktop. To restore a minimized window, all you have to do is click the window's button on the Windows 
Taskbar (at the bottom of the screen). 

If what you really want to do is close the window (and close any program running within the window), just click 
the window's Close button. 

CAUTION   If you try to close a window that contains a document you haven't saved, you'll be prompted to save 
the changes to the document. Because you probably don't want to lose any of your work, click Yes to save the 
document and then close the program. 
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Scrolling Through a Window - 

Many windows contain more information than can be displayed at once. When you have a long document or 
Web page, only the first part of the document or page is displayed in the window. To view the rest of the 

document or page, you have to scroll down through the window, using the various parts of the scroll 
bar  Use the scrollbar to scroll through long pages. 

There are several ways to scroll through a window. To scroll up or down a line at a time, click the up 
or down arrow on the window's scrollbar. To move to a specific place in a long document, use your 
mouse to grab the scroll box (between the up and down arrows) and drag it to a new position. You 
can also click on the scroll bar between the scroll box and the end arrow, which scrolls you one 
screen at a time. 

If your mouse has a scroll wheel, you can use it to scroll through a long document. Just roll the wheel back or 
forward to scroll down or up through a window. 

Using Menus - 

Most windows in Windows use a set of pull-down menus to store all the commands and operations you can 
perform. The menus are aligned across the top of the window, just below the title bar, in what is called a menu 
bar. 

You open (or pull down) a menu by clicking the menu's name. The full menu then appears just below the menu 
bar.You activate a command or select a menu item by clicking it with your mouse. 

 Navigating Windows' menu system. 

Some menu items have a little black arrow to the right of the label. This indicates that additional 
choices are available, displayed on a submenu. Click the menu item or the arrow to display the 
submenu. 

Other menu items have three little dots (called an ellipsis) to the right of the label. This indicates that additional 
choices are available, displayed in a dialog box. Click the menu item to display the dialog box. 

The nice thing is, after you get the hang of this menu thing in one program, the menus should be very similar in 
all the other programs you use. For example, almost all programs have a File menu that lets you open, save, 
and close documents, as well as an Edit menu that lets you cut, copy, and paste. While each program has 
menus and menu items specific to its own needs, these common menus make it easy to get up and running 
when you install new software programs on your system. 

Using Toolbars - 

Some Windows programs put the most frequently used operations on one or more toolbars, typically located 
just below the menu bar..) A toolbar looks like a row of buttons, each with a small picture (called an icon) and 
maybe a bit of text. You activate the associated command or operation by clicking the button with your mouse. 

If the toolbar is too long to display fully on your screen, you'll see a right arrow at the far-right side of the toolbar. 
Click this arrow to display the buttons that aren't currently visible. 

Using Dialog Boxes, Tabs, and Buttons - 

There are several different types of dialog boxes, each one customized to the task at hand. However, most 
dialog boxes share a set of common features, which include the following: 

javascript:popUp('/content/images/chap3_0789731754/elementLinks/03fig04.jpg')
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 Buttons—Most buttons either register your inputs or open an auxiliary dialog box. The most common 
buttons are OK (to register your inputs and close the dialog box), Cancel (to close the dialog box without 
registering your inputs), and Apply (to register your inputs without closing the dialog box). Click a button 
once to activate it. 

 Tabs—These allow a single dialog box to display multiple "pages" of information. Think of each tab, 
arranged across the top of the dialog box, as a "thumbtab" to the individual page in the dialog box below 
it. Click the top of a tab to change to that particular page of information. 

 Text boxes—These are empty boxes where you type in a response. Position your cursor over the empty 
input box, click your left mouse button, and begin typing. 

 Lists—These are lists of available choices; lists can either scroll or drop down from what looks like an 
input box. Select an item from the list with your mouse; you can select multiple items in some lists by 
holding down the Ctrl key while clicking with your mouse. 

 Check boxes—These are boxes that let you select (or deselect) various standalone options. 
 Sliders—These are sliding bars that let you select increments between two extremes, similar to a sliding 

volume control on an audio system. 

Name of control and picture 
 

Description  
 

(Command) Button  Buttons (also called command buttons) do something when clicked.  

Check box  
A check box turns something on or off. There is a check in the box if it is on, to 
change it click on it.  

Text box  Also called edit boxes, these boxes let you type text in them.  

Radio button 
Also called option buttons, these boxes come in groups, you can only pick one 
per group.  

List box These boxes contain lists of things: you can select one.  

Combo box 
Also called drop-down boxes, these boxes are like text boxes, but they have a 
button on the side that, when clicked, brings up a list of things that you can 
pick from.  

Spin button 
These buttons increase or decrease numerical values by one when the up or 
down arrow half is clicked.  

Scroll bar 
Click on the arrows at the top and bottom of these bars to move the screen, 
you can also drag the box that is on the bar.  

Label 
Often overlooked, labels don’t do anything, but they sit near other controls with 
text in them to tell you what those things are.  

 

Mouse Operations 

There are four basic mouse operations that you can perform: 

 

<Click>     

To select an item or choose a menu command, point the mouse at it with the pointer and <Click> the left mouse 

button. 

  

<Click and Drag> 

To move an item is called dragging.  To complete this operation, point at the item, <Click> it and hold down the 

left mouse button.  While holding down the left mouse button drag the item where you want it to be. Release the 

button.  Note:  Practice this a bit before doing it, since you can inadvertently drag an item anywhere. 

 

 

 

https://en.wikibooks.org/wiki/File:UI-Button.png
https://en.wikibooks.org/wiki/File:UI-Checkbox.png
https://en.wikibooks.org/wiki/File:UI-Textbox.png
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<Double-Click>  

This is a shortcut method used to access an item or to open or close a window quickly without using a menu.  

To complete this operation, point the mouse pointer to the item and <Double-Click> it with the left mouse 

button. 

 

<Right-Click> 

When you click the right mouse button you can access a drop down menu to choose what you can do with the 

item, such as "copy,"paste", etc.  Every menu is specific to what you click.  To perform this operation, point at 

the desired item or object and <Click> the right mouse button ONLY once. 
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UNIT -5 

WORKING WITH MS – OFFICE 

 

Components of the MS Word Window 

 

Besides the usual PC window components (close box, title bar, scroll bars, etc.), a Word window has 

other elements 

 

Component Functionality or Purpose of the Component  

Menu Bar Contains File,Edit, View, Insert, Format, Tools, Table, Window and Help menus 

Standard Toolbar Contains icons for shortcuts to menu commands. 

Formatting Tool Bar Contains pop-up menus for style, font, and font size; icons for boldface, italic, and underline; 

alignment icons; number and bullet list icons; indention icons, the border icon, highlight, and font 

color icons. 

Ruler Ruler on which you can set tabs, paragraph alignment, and other formats. 

Insertion Point Blinking vertical bar that indicates where text you type will be inserted. Don’t confuse the insertion 

point with the mouse I-beam. To move the insertion point, just click the mouse where you want the 

point moved. 

End-of-File Marker Non-printing symbol that marks the end of the file. You cannot insert text after this mark. 

Selection Bar 

(Gutter) 
Invisible narrow strip along the left edge of the window. Your mouse pointer changes to a right-

pointing arrow when it is in this area. It is used to select a line, a paragraph, or the entire document. 

Split Handle Double-click to split the window in two (to view different portions of the same file). Double-click to 

return to one window 

Status Bar Displays page number, section number, and total number of pages, pointer position on page and 

time of day. 

Task Pane Displays and groups commonly used features for convenience. 

Office Assistant An animated character that can provide help and suggestions. There are multiple characters to 

choose from, and it is possible to turn the Office Assistant off. 

  

A blank document, ready to type in. 

 

Callout 1 The first document you open is called Document1 in the title bar at the top of the window. 

Callout 2 The menu bar. The File menu is the first one on the left. 

Callout 3 The Standard and Formatting toolbars. 

Callout 4 The insertion point. 

 

When you start Word, a new file opens. That file is called a document. Above the document you’ll 

see the menu bar and the toolbars displayed across the top of the window, as shown in the illustration. 
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If you’ve already started Word, you create a new document by clicking New on the File menu. In the 

New Document task pane that opens, click Blank document. 

 

In the upper-left corner of the document, or page, is the insertion point, a blinking vertical line. The first 

thing you type will appear there. You can start further down the page if you want to by pressing 

ENTER until the insertion point is where you want the first line to begin. As you type, the insertion 

point moves to the right. 

 

If you’re typing a letter, you might start by typing the date. After that, press ENTER to move the 

insertion point down the page one line. 

 

Components of the MS Excel Window 

 

Microsoft excel is a spreadsheet program. Spreadsheets present tables of values arranged in rows 

and columns that can be manipulated mathematically using both basic and complex arithmetic 

operations and functions. 

 

It has varios components, major being:- 

 

Title Bar:- The title bar displays both the name of the application and the name of the spreadsheet. 

The topmost blue bar with excel logo in the image. 

 

Menu Bar:- The menu bar displays all of the menus available for use in Excel XP. The contents of any 

menu can be displayed by left-clicking the menu name. The bar below Title bar with File, Edit, View 

options in the image is called menu bar. 
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Column Headings: Each Excel spreadsheet contains 256 columns. Each column is named by a letter 

or combination of letters. 

 

Row Headings: Each spreadsheet contains 65,536 rows. Each row is named by a number. 

 

Formula Bar: The formula bar isplays information entered—or being entered as you type—in the 

current or active cell. The contents of a cell can also be edited in the formula bar. 

 

Cell: A cell is an intersection of a column and row. Each cell has a unique cell address. In the picture 

above, the cell address of the selected cell is A1. The heavy border around the selected cell is called 

the cell pointer. 

 

Workbook and worksheets: Each sheet you see on screen is called worksheet and collections of 

these sheets is together called as a workbook. 

 

 
 

 

Components of the MS Power Point Window 

 

PowerPoint's many features can be overwhelming to new presenters. As you work with the program, it 

can be useful to create a list of the PowerPoint elements you use most often. Consider the operations 

you perform in PowerPoint, as well as the content and data that those operations impact. A benefit of 

listing PowerPoint's elements is that you can concentrate on learning one element at a time. Here’s a 

sample element list that you can use as a template for making your own: PowerPoint’s user interface, 

slides, content, formatting, and presentation playback. 
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User Interface 

The most visible element of PowerPoint is its user interface—the screens, dialog boxes, buttons, 

panes, and other parts of the application window. The biggest part of the interface is the pane for 

creating and editing slides. The toolbar, called the Ribbon, is another big chunk of the application 

window. For example, if you insert an arrow shape on a slide, the Ribbon will display a new tab: 

"Drawing Tools." This tab is filled with previously unavailable commands for formatting the arrow. 

 

Slides 

The slide is the PowerPoint element on which you insert text, graphics, audio, video, and animations. 

You can create new slides by pressing “Ctrl-M” or by clicking “New Slide” on the Home tab. Delete 

slides by selecting them in PowerPoint‘s left pane and then pressing the “Delete” key. Arrange slides 

by dragging them in the slide thumbnail pane. Change slide dimensions by clicking the "Page Setup” 

button on the Design tab. 

 

Content 

PowerPoint's content types include static text and graphics, audio, video, and animation created inside 

PowerPoint itself. Most of the commands for creating content are on the Insert tab. For example, the 

Media Clips group has a "Movie" option for importing videos. Use the Animation tab for creating new 

animations, such as entrance and exit effects on a slide's graphics and text. 

 

Formatting 

Formatting commands are the PowerPoint element with which you decorate the content on your 

slides. The Home tab, for example, has many of the same formatting commands as Microsoft Word, 

including character-level tools such as "Bold," and paragraph-level tools that include "Align Text Left." 

Another tab, "Design," has a group of commands called Themes that let you apply font and color 

changes to all of the slides in your presentation at once. 

 

Presentation Playback 

The final slide presentation will be the only PowerPoint element that your audience sees, if you’ve 

saved the presentation with the extension PPSX. In that case, clicking the PPSX file brings up the 

presentation directly, and not the PowerPoint interface you used to create the presentation. But if 

you’ve saved the presentation with the PPTX extension, the PowerPoint interface will appear—if 

PowerPoint is installed on the computer. Computers without the main PowerPoint application can still 

run PowerPoint presentations by using Microsoft's free PowerPoint viewer. 
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UNIT 6 

WORKING WITH INTERNET 

 

What is the Internet? 

The Internet is a world wide network of computers that are connected (networked) and are using the 

communication method called TCP/IP. The Internet was named ARPANET in 1969 by the Advanced 

Research Projects Agency of the U.S. Department of Defense with just four computers connected 

together.  

 

What is the World Wide Web? 

Also called web or www, it is a collection of information, resources, pictures, sounds, multimedia on 

the internet that are linked and connected together. Using a software product such as Netscape 

makes accessing and linking to web pages containing information, easy. The world wide web was 

invented by Tim Bernes-lee in the CERN Laboratory in March 1989.  

 

What is a Host? 

A computer that is used to transfer data on the Internet.  

 

What is DNS? 

DNS (Domain Name System) is a large database of domain names and their correspondent Internet 

(IP Addresses) for example: www.widget.com corrisponds to it's unique number 207.168.6.12  

 

What is HTML? 

Hypertext Markup Language is a coding language used to tell a browser how to place pictures, text, 

multimedia and links to create a web page. When a user clicks on a link within a web page, that link, 

which is coded with HTML, links the user to a specific linked web page.  

 

HTTP - The hypertext transfer protocol (http) that enables html documents to be read on the Internet.  

 

What is Hypertext? 

Hypertext is text on a webpage that links to another document or webpage. The hypertext link can be 

as small as a letter or word, or as big as all the text on the page.  

 

What is FTP? 

File Transfer Protocal is a method of transferring files between two computers on the Internet. To 

access, upload or download information on a server computer (or a computer that accesses a server 

computer), FTP software makes the information access or transfer possible.  

 

What is a home Page? 

A home Page is the main or index page of a web site. For example, if a user opens Netscape or 

Internet Explorer and types the URL, http://www.commentum.com, that would open the home Page of 

the Commentum Communications company.  
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What is a URL? 

Uniform Resource Locator is a web address used to connect to a remote resource on the world wide 

web. 

For example: 

https://www.comentum.com 

ftp://ftp.comentum.com 

telnet://info.comentum.com  

 

Create an E-mail Account: 

 

How to create a Gmail account? 

 

You can use your username and password to sign in to Gmail and other Google products like 

YouTube, Google Play, and Google Drive. Follow the steps, create your Gmail account and start 

sending emails. 

 

Step 1: Visit Google account creation page, accounts.google.com 

 

Step 2: Click on Create account, choose for myself. 

 

Step 3: The sign-up form will appear. Enter your first and last name. 

 
 

Step 4: Choose a Username for your account. (Here you can also use an existing email address) 

 

Step 5: After choosing a username, enter a password. Type the password again to confirm. (As per 

Google's instruction always use 8 or more characters with a mix of letters, numbers & symbols) 

 

Step 6: At last tap on Next. (Right corner of the screen) 

 

 

Step 7: On the next page enter your phone number to verify your account. (It is a two-step 

verification process for security) 



23 
 

 
 

Step 8: On the given mobile number you will receive a text message from Google with a verification 

code. Enter the verification code and tap on Verify. 

 

Step 9: On the next page enter your DOB in the specified fields. 

 
 

Step 10: Choose a Gender. 

 
 

Step 11: Tap on Next. 

 

Step 12: Read, Google's Terms of Service and Privacy Policy will appear on the screen and click on I 

agree. 

 
 

Congratulations! your account has been created. From now onwards every time you sign in you just 

have to enter your email id and password. And every time you sign-in don't forget to sign-out because 

it prevents others from viewing your emails. 
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How to send an email  

 

Step 1: Login your Gmail account, using Id and password. 

 

Step 2: On the new page, click Compose (In the top left). 

Step 3: A box appears on the screen, here in the To field, add recipients email id. (If you want, you 

can also add recipients in the Cc and Bcc fields) 

 

[CC is carbon copy, which means the e-mail sent to all the recipients can see every other  

E-mail ID] 

 

[BCC is Blind Carbon Copy, which means no recipient can see other recipients for a particular 

E-mail message] 

 

Step 4: After that add a subject. 

 

Step 5: In the body, write your message. 

 

Step 6: At the bottom of the page, there is a send option-click Send to send mail. 
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UNIT – 7 

C PROGRAMMING 

 

Write a program in c to find the greatest among three numbers. 

#include <stdio.h> 

#include<conio.h> 

 void main() 

{ 

    double n1, n2, n3; 

    printf("Enter three numbers: "); 

    scanf("%lf %lf %lf", &n1, &n2, &n3); 

     if( n1>=n2 && n1>=n3) 

    printf("%.2lf is the largest number.", n1); 

    else if (n2>=n1 && n2>=n3) 

    printf("%.2lf is the largest number.", n2); 

    else 

    printf("%.2lf is the largest number.", n3); 

    getch(); 

} 

 

Write a program in C to find the average of n numbers using for loop. 

#include<stdio.h> 

#include<conio.h> 

Void main() 

{ 

      int n,c; 

      float a,sum=0; 

      printf("enter a number\n"); 

      scanf("%d",&n); 

      for(c=1;c<=n;c++) 

      { 

                      sum=sum+c; 

                      printf("%d+",c); 

                      } 

                      a=sum/(n+1); 

                      printf("=%f\n",sum); 

                      printf("average=%f",a); 

                      getch(); 

         } 
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Write a program in C to find if a number is prime or not. 

#include <stdio.h> 

int main() 

{ 

    int n, i, flag = 0; 

    printf("Enter a positive integer: "); 

    scanf("%d", &n); 

    for(i = 2; i <= n/2; ++i) 

    if(n%i == 0) 

        { 

            flag = 1; 

            break; 

        } 

    } 

    if (n == 1)  

    { 

      printf("1 is neither a prime nor a composite number."); 

    } 

    else  

    { 

        if (flag == 0) 

        printf("%d is a prime number.", n); 

        else 

        printf("%d is not a prime number.", n); 

    } 

        return 0; 

} 

 

Write a program in C to check whether a number is palindrome or not. 

#include <stdio.h> 

int main() 

{ 

    int n, reversedInteger = 0, remainder, originalInteger; 

    printf("Enter an integer: "); 

    scanf("%d", &n); 

    originalInteger = n; 

    // reversed integer is stored in variable  

    while( n!=0 ) 

    { 

        remainder = n%10; 

        reversedInteger = reversedInteger*10 + remainder; 

        n /= 10; 

    } 
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    // palindrome if orignalInteger and reversedInteger are equal 

    if (originalInteger == reversedInteger) 

        printf("%d is a palindrome.", originalInteger); 

    else 

        printf("%d is not a palindrome.", originalInteger); 

        return 0; 

} 

 

Write a program in  C to compute Sine Series. 

#include<stdio.h> 

#include<conio.h> 

void main() 

{ 

    int i, n; 

    float x, sum, t; 

    clrscr(); 

    printf(" Enter the value for x : "); 

    scanf("%f",&x); 

    printf(" Enter the value for n : "); 

    scanf("%d",&n); 

    x=x*3.14159/180; 

    t=x; 

    sum=x; 

         /* Loop to calculate the value of Sine */ 

    for(i=1;i<=n;i++) 

    { 

        t=(t*(-1)*x*x)/(2*i*(2*i+1)); 

        sum=sum+t; 

    } 

    printf(" The value of Sin(%f) = %.4f",x,sum); 

    getch(); 

} 

 

Write a program in C to accept row wise and column wise elements in a 2D array and print 

them. 

#include <stdio.h> 

 #define MAXROW    10 

#define MAXCOL      10 

 int main() 

{ 

    int matrix[MAXROW][MAXCOL]; 

    int i,j,r,c; 

    printf("Enter number of Rows :"); 

    scanf("%d",&r); 



28 
 

    printf("Enter number of Cols :"); 

    scanf("%d",&c); 

    printf("\nEnter matrix elements :\n"); 

    for(i=0;i< r;i++) 

    { 

        for(j=0;j< c;j++) 

        { 

            printf("Enter element [%d,%d] : ",i+1,j+1); 

            scanf("%d",&matrix[i][j]); 

        } 

    } 

    printf("\nMatrix is :\n"); 

    for(i=0;i< r;i++) 

    { 

        for(j=0;j< c;j++) 

        { 

            printf("%d\t",matrix[i][j]); 

        } 

        printf("\n");   /*new line after row elements*/ 

    } 

    return 0;    

} 

 

Write a program in C to print vowels in a given string. 

#include <stdio.h> 

int main() 

{ 

 int index, str_length; 

 //Create char buffer to store string 

 char str[50]; 

 printf("\nEnter string: "); 

 scanf("%[^\n]s", str); 

 str_length = strlen(str); 

 for(index = 0; index < str_length; index++) 

 { 

  if(str[index] == 'a' || str[index] == 'e' || 

   str[index] == 'i' || str[index] == 'o' ||  

   str[index] == 'u' || str[index] == 'A' || 

   str[index] == 'E' || str[index] == 'I' || 

   str[index] == 'O' || str[index] == 'U') 

  { 

   printf("Vowel: %c at location: %d\n",str[index], index ); 

  } 

 } 
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 return 0; 

} 

 

Write a program in C to find the factorial of a number using recursion. 

#include<stdio.h> 

int find_factorial(int); 

int main() 

{ 

   int num, fact; 

   printf("\nEnter any integer number:"); 

   scanf("%d",&num); 

    fact =find_factorial(num); 

    printf("\nfactorial of %d is: %d",num, fact); 

   return 0; 

} 

int find_factorial(int n) 

{ 

   if(n==0) 

      return(1); 

  

   //Function calling itself: recursion 

   return(n*find_factorial(n-1)); 

} 

 

Write a program in C to find the sum of Fibonacci series , by using function. 

#include<stdio.h> 

 int Fibonacci(int); 

 int main() 

{ 

   int n, i = 0, c; 

    scanf("%d",&n); 

    printf("Fibonacci series\n"); 

    for ( c = 1 ; c <= n ; c++ ) 

   { 

      printf("%d\n", Fibonacci(i)); 

      i++;  

   } 

    return 0; 

} 

 int Fibonacci(int n) 

{ 

   if ( n == 0 ) 

      return 0; 
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   else if ( n == 1 ) 

      return 1; 

   else 

      return ( Fibonacci(n-1) + Fibonacci(n-2) ); 

} 

  

Write a program in C to accept a number from keyboard and print it in reverse order of entry, 

by using function. 

#include <stdio.h> 

long reverse(long); 

 int main() 

{ 

   long n, r; 

   scanf("%ld", &n); 

    r = reverse(n); 

   printf("%ld\n", r); 

    return 0; 

} 

long reverse(long n)  

{ 

   static long r = 0; 

      if (n == 0) 

      return 0; 

      r = r * 10; 

      r = r + n % 10; 

      reverse(n/10); 

      return r; 

} 
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